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トゥーンシェーディング

トゥーンシェーディングの概要
トゥーンシェーディングでは、3D モデリングおよびアニメーションのソフトウェ
アを使用して、2D セルやカートゥーンアニメーションの外観を作成します。
「トゥーン」の外観のエレメントとしては、プロファイルライン（アウトライ
ン）、境界線、折り目線、交差線、およびソリッドカラーシェーディングが挙げ
られます。これらのエレメントを結合すると、従来のアニメーションの「主線」
と「塗り」のテクニックによる外観が再現されます。ここで、主線とはラインを
指し、塗りはシェーディングを指します。

レンダリング（Rendering）メニューセットにトゥーン（Toon）メニューが導入
されています。新しいトゥーンメニューには、特にトゥーンシェーディング作成
用に各種項目やツールが含まれており、以下のことを実行できます。

■ 塗りつぶしシェーダのサーフェスへの追加や、ランプ（Ramp）シェーダでカ
スタムの塗りつぶしシェーダを作成できます。

1
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■ オフセットサーフェスまたは Maya® Paint Effects™ を使用してプロファイ
ルラインを追加し、あらゆるものにアウトラインを加えて、トゥーンライ
ンの外観を作成します。

■ 境界線を追加します。

■ 折り目線を追加します。

■ 交差線を追加します。

■ レンダリングのバックグラウンドカラーを設定します。

■ ペイントエフェクト（Paint Effects）ブラシをトゥーンラインに割り当てま
す。

■ トゥーンラインをポリゴンに変換します。

■ ペイント、トゥーンラインモディファイアの適用、その他のトゥーンライ
ンのアトリビュートの編集によって、ラインの特性を調整します。

注: ビデオカードがハードウェアレンダリングに適しておらず、シーンビュー
での表示（たとえば、トゥーン（Toon）シェーディング）に影響するおそれが
ある場合、Maya は警告メッセージを表示します。この場合、シーンビューで
のシェーディングは非高精度レンダリング（High Quality rendering）でのシェー
ディングや、ハードウェアレンダラを使用しないシェーディングとなります。

トゥーンのサンプル
トゥーンラインおよびシェーディングエフェクトのサンプルファイルをイン
ポートすることができます。これらのファイルを変更してトゥーンスタイルを
カスタマイズすることができます。また、サンプルファイルは、独自のトゥー
ンスタイルの作成方法を理解するための学習ツールとして使用したり、単にア
イデアを得る方法として使用したりできます。
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トゥーンのサンプルをシーンにインポートするには

1 レンダリング（Rendering）メニューセットでトゥーン > トゥーンサンプ
ルの取得（Toon > Get Toon Example）を選択します。バイザー（Visor）
ウィンドウがトゥーン サンプル（Toon Examples）タブに開きます。

2 目的のトゥーン（Toon）サンプルを右マウスボタンでクリックして、イン
ポート（Import）を選択します。Autodesk® Maya® が pfxToon ライン
ノード、シェーダ、サーフェスをシーンにインポートします。

アトリビュート エディタ（Attribute Editor）の下部にある注（Notes）セ
クションに、トゥーン（Toon）サンプルについての情報が表示されてお
り、トゥーン構築の重要事項が挙げられています。

トゥーンラインとシェーディングをシーンに追
加する

トゥーンラインは、3 つのタイプのジオメトリ、つまり NURBS、ポリゴン、サ
ブディビジョンサーフェスに使用できます。また、ストローク、ペイントエフェ
クト（Paint Effects）ブラシ、ペイント エフェクト（Paint Effects）ヘアにも使
用できます。トゥーンラインは、入力ジオメトリと現在選択しているビューと
を組み合わせたものから直接生成されます。トゥーンラインの外観は、pfxToon
ノードのアトリビュートを使用して制御できます。このアトリビュートの詳細に
ついては、pfxToonShape ノード (37 ページ)を参照してください。ペイント エ
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フェクト（Paint Effects）を使用すると、追加のラインをペイントすることもで
きます。

トゥーン シェーディングをシーンに追加するには

1 2D でレンダーしたいジオメトリを作成します。

2 トゥーン（Toon）シェーダをジオメトリに割り当てます（トゥーン > 塗り
つぶしシェーダの割り当て（Toon > Assign Fill Shader））。

3 トゥーン（Toon）のアウトラインをジオメトリに割り当てます（トゥーン
> アウトラインの割り当て（Tool > Assign Outline））。

4 オプションで、レンダリングするシーンのバックグラウンドカラーを設定
します（トゥーン > カメラのバックグラウンドカラーを設定（Toon > Set
Camera Background Color））。

5 シーンをレンダーします。

レンダリングするときは以下のことに注意してください。

■ トゥーンラインはすべて、Maya ソフトウェア（Maya Software）レン
ダラを使用してレンダーできます。

■ プロファイルラインにペイント エフェクト（Paint Effects）方法を使
用した場合は、Maya ソフトウェア（Maya Software）レンダラでレン
ダーする前に、レンダー設定 （Render Settings）ウィンドウの Maya
ソフトウェア（Maya Software）タブにあるペイント エフェクト レン
ダリング オプション（Paint Effects Rendering Options）セクション
で、オーバーサンプル（Oversample）とポスト フィルタのオーバー サ
ンプル（Oversample Post Filter）のチェックボックスをオンにしま
す。

■ mental ray® for Maya レンダラまたは Maya ハードウェア（Maya
Hardware）レンダラを使用してペイント エフェクト（Paint Effects）
トゥーンラインをレンダーするには、まずトゥーンラインをポリゴン
に変換する必要があります。詳細については、トゥーンラインをポリゴ
ンに変換するには(18ページ)を参照してください。あるいは、プロファ
イルラインにオフセット メッシュ（Offset Mesh）方法を使用すると、
これらのレンダラでレンダーが行われます（この方法は、pfxToonShape
ノードのプロファイル ライン（Profile Lines）セクションで設定できま
す）。

4 | 第 1 章   トゥーン シェーディング



トゥーンラインのタイプ
Maya で編集できるトゥーンラインには 4 タイプあります。プロファイル、境
界、折り目、および交差の各ラインです。これらのラインは、メッシュのプロパ
ティとして定義します。したがって、メッシュ以外のジオメトリタイプはすべ
て、ポリゴンメッシュに変換してから pfxToon ノードに渡します。

プロファイル ライン（Profile Lines） プロファイル ライン（Profile Lines）は、
オブジェクトがビューから外れる位置で発生するシルエットライン（外郭線）
です。プロファイルラインにペイント エフェクト（Paint Effects）を使用して
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いる場合は、ビューが変化するときにプロファイルラインが生成されます。プ
ロファイルラインにオフセット メッシュ（Offset Mesh）を使用している場合
は、更新機能が備わっているので、ペイント エフェクト（Paint Effects）方法で
行う場合よりもリフレッシュが遅くなることはありません。ビューによっては、
プロファイルラインは折り目線と一致する場合があります（折り目のエッジも
外郭線内にある場合）。プロファイルラインの外観の変更に使用できるアトリ
ビュートについては、プロファイルライン（Profile Lines）を参照してくださ
い。

折り目線（Crease Lines） 折り目線（Crease Lines）は、定義されている最小折
り目角度（Crease Angle Min）の値よりも、曲がっている角度が大きいポリゴ
ンエッジ上に形成されます。プロファイルラインとは異なり、折り目線はビュー
依存ではありません。たとえば、立方体のエッジが手前方向を向いている場合で
も、折り目線を使用して立方体のエッジを描画できます。折り目線の外観の変更
に使用できるアトリビュートについては、折り目線（Crease Lines）(38ページ)
を参照してください。
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境界線（Border Lines） 境界線（Border Lines）は、単一のポリゴンフェース
の部分にしかないエッジ上に発生します。たとえば、単純なプレーンのエッジは
境界線です。境界線の外観の変更に使用できるアトリビュートについては、境界
線（Border Lines） (38 ページ)を参照してください。

交差線（Intersection Lines） 交差線（Intersection Lines）は、オブジェクトが
他のオブジェクトにオーバーラップする位置である交差上に発生します。たとえ
ば、トゥーンの眼球は、球体を頭部に付け、交差線を使用してカートゥーンの目
を表すことで作成できます。

2 つのオブジェクトでその間に交差線がある場合、交差線は同じトゥーンライ
ンノードに割り当てる必要があります。ただし、オブジェクト上で複数のトゥー
ンラインノードをレイヤ化することができます。また、必要に応じて、いくつ
かの異なるトゥーンラインノードを交差にだけ使用して、その他のトゥーンラ
インノードをプロファイルラインおよび折り目線に使用することができます。

交差線の外観を制御するには、pfxToonShape ノードの交差線（Intersection
Lines）セクションにあるアトリビュートを使用します。詳細については、交差
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線（Intersection Lines）(38ページ)を参照してください。これらのアトリビュー
トは、プロファイルラインと折り目線のアトリビュートと似ており、その他の
ラインタイプの場合とほぼ同じように機能します。固有の自己交差（Self
Intersect）アトリビュートが存在しています。最小/最大交差角度（Intersection
Angle Min/Max）アトリビュートは、サーフェスが交差する位置での角度の勾
配に基づいて、線の太さ/細さの変化を制御します。最小交差角度（Intersection
Angle Min）の値をゼロより大きくすると、2 つのサーフェスが相対的に同一平
面上にあることになる位置に交差線が作成されないようにできます。また、修正
> 変換 > ペイントエフェクトをカーブに（Modify > Convert > Paint Effects to
Curves）を使用し、ヒストリを持つ NURBS カーブを交差に沿って生成すること
もできます。

トゥーンラインのコネクション
さまざなまトゥーンシェーディングノードを、曲率の変化を検出できるように、
オブジェクトおよびカメラにコネクトします。それぞれの塗りつぶしシェーダお
よびトゥーンラインシェーダには独自のノードがありますが、複数のオブジェ
クトを同じ塗りつぶしシェーダまたはトゥーンラインシェーダににコネクトす
ることができます。たとえば、次のイメージにあるトーラス、コーン、シリンダ
の 3 つのオブジェクトはすべて、同じトゥーンラインノード（pfxToonShape1）
にコネクトされています。ただし、これらのオブジェクトはそれぞれ固有の塗り
つぶしシェーダを持っています。床を表すプレーンには独自のトゥーンライン
ノード（pfxToonShape2）および塗りつぶしシェーダ（surfaceShader4SG）が
存在します。2 番目のイメージではすべてのコネクションを確認できます。
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トゥーンラインによる作業

トゥーンラインの非表示および表示
トゥーンラインはペイント エフェクト（Paint Effects）のストロークなので、
これらの関連方法を使用してトゥーンラインを非表示にしたり、pfxToonShape
ノードでビューポートで表示（Display In Viewport）オプションをオフにする
ことができます。詳細については、トゥーンラインのトラブルシューティング
(27 ページ)を参照してください。

トゥーン ラインを非表示にするには

 ➤ 次のいずれかを実行します。
■ 非表示にするトゥーンラインを選択し、pfxToon ノードでビューポー

トで表示（Display In Viewport）チェックボックスをオフにします。
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■ パネルメニューで表示 > ストローク（Show > Strokes）を選択して
チェックを外します。

トゥーン ラインを表示するには

 ➤ 次のいずれかを実行します。
■ 表示するトゥーンラインを含むジオメトリを選択し、pfxToon ノード

でビューポートで表示（Display In Viewport）チェックボックスをオ
ンにします。

■ パネルメニューで表示 > ストローク（Show > Strokes）を選択解除し
ます。

トゥーンラインのアトリビュートを変更する
トゥーンラインの各種のアトリビュートを pfxToon ノードで変更することがで
きます。また、プロファイルライン、折り目線、境界線、交差線を含むライン
タイプに固有のアトリビュートも存在しています。異なるエフェクトに対して複
数のトゥーンラインノードを作成できます。たとえば、曲率の調整など、固有
のトゥーンラインノードを折り目線に含める場合が挙げられます。

トゥーン ラインのアトリビュートを変更するには

1 編集するトゥーンラインを選択します。

2 アトリビュート エディタ（Attribute Editor）の pfxToon ノードで、目的
のトゥーンラインのアトリビュートを選択します。これらのアトリビュー
トの詳細については、pfxToonShape ノード (37 ページ)を参照してくださ
い。

トゥーン ラインのアトリビュートを変更する | 11



トゥーンラインのアトリビュートをペイントする
トゥーンラインは、ラインの幅（Line Width）、ライン オフセット（Line
Offset）、ライン不透明度（Line Opacity）、プロファイル カラー（Profile
Color）、折り目のカラー（Crease Color）、境界カラー（Border Color）など
の特定のアトリビュートを持つトゥーンラインをペイントできます。独自の
トゥーンラインをペイントすることで、特定の場所のトゥーンラインの外観を
変更できます。

トゥーン ラインのアトリビュートをペイントするには

1 ペイントするトゥーンラインを選択します。

ライン自体をクリックするか、またはサーフェス上にトゥーンラインが 1
つしかない場合は、サーフェスをクリックします。

2 トゥーン > ラインアトリビュートのペイント（Toon > Paint Line
Attributes）を選択し、変更するラインのアトリビュートをメニューから選
択します。

3D ペイント ツール（3D Paint Tool）設定エディタが表示されます。表示
されない場合は、Maya ウィンドウの右上にあるツール設定の表示/非表示
を切り替え（Show or hide the Tool Settings）アイコンをクリックしま
す。

3 ファイル テクスチャ（File Texture）セクションにあるペイントするアトリ
ビュート（Attribute to Paint）オプションで、ペイントしているラインの
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アトリビュートがわかります。このアトリビュートを変更するには、トゥー
ン > ラインアトリビュートのペイント（Toon > Paint Line Attributes）の
メニュー項目を使用する必要があります。

4 ファイル テクスチャ（File Textures）セクションにあるストローク時に更
新（Update on Stroke）がオンになっていることを確認します。

5 カラー（Color）セクションにあるカラースライダをドラッグします。たと
えば、ラインの幅（Line Width）をペイントしている場合、黒色でペイン
トするとライン幅の値が小さくなり、白色でペイントするとライン幅はペ
イント前のオリジナルの値に戻ります。

6 トゥーンラインをペイントします。

注: ペイント時には、ペイントのフィードバック用に一時的なシェーダが
サーフェスに適用されます。オリジナルのシェーダは、このツールの終了
時に復元されます。この 3D ペイント ツールを再びアクティブにするだけ
では、ペイントは再開されません。このツールは、必ずトゥーン > ライン
アトリビュートのペイント（Toon > Paint Line Attributes）のメニューか
ら起動する必要があります。ツール ボックス（Toolbox）で最後に使用し
たツールを選択しないでください。もし選択すると3D ペイントツール（3D
Paint Tool）がロードされますが、トゥーンラインのアトリビュートのペ
イントに適するようにはロードされません。
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ペイント エフェクトをトゥーンラインで使用する
ペイント エフェクト（Paint Effects）ブラシをトゥーンラインに割り当てて、
おもしろいエフェクトを作成することができます。たとえば、汚れたトゥーン
ラインやメタリックなトゥーンラインなどが挙げられます。

また、ペイント エフェクト（Paint Effects）ブラシを使用して、追加のトゥーン
ラインをペイントすることもできます。詳細については、トゥーンシーンで追
加のラインをペイントする (17 ページ)を参照してください。

ペイント エフェクト（Paint Effects）ブラシをトゥーン ラインにアタッチする
には

1 ペイント エフェクト（Paint Effects）ブラシを割り当てるトゥーンライン
を選択します。

2 次のいずれかの方法で、ペイント エフェクト（Paint Effects）ブラシを選
択します。
■ ペイントエフェクト > ブラシを取得（Paint Effects > Get Brush）を選

択して、バイザー（Visor）ウィンドウからブラシを選択します。すべ
てのペイント エフェクト（Paint Effects）ブラシを使用できますが、
トゥーン（Toon）フォルダ内のブラシが特に適しています。

■ ペイント エフェクト（Paint Effects）シェルフからブラシを選択しま
す。

3 トゥーン > ペイントエフェクトブラシをトゥーンラインに割り当て（Toon
> Assign Paint Effects Brush to Toon Lines）を選択します。選択したブラ
シが選択したトゥーンラインにアタッチされます。

4 ブラシのアトリビュートを編集します。トゥーンのアトリビュートを使用
してラインをスケールできるようにするには、ブラシのグローバル スケー
ル（Global Scale）の値を 1 にします。
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ヒント: チューブをオンにしてペイント エフェクト（Paint Effects）ブラシ
（たとえばつる草（vine）ブラシ）を割り当てた後、トゥーンラインの再
描画時に発生する「乱れ」を取り除くには、以下の操作を実行します。
■ スムース プロファイル（Smooth Profile）をオンにします。

■ プロファイルのリサンプル（Resample Profile）をオンにします。

■ リサンプリング用の最小セグメント長（Min Segment Length）の値を
大きくします。

■ 最大セグメント長（Max Segment Length）を、リサンプリング用の最
小セグメント長と同じに設定します。

モディファイアを使用してトゥーンラインとブラシ
のアトリビュートを変更する

モディファイアを使用して、特定のトゥーンラインとブラシチューブのアトリ
ビュートを操作することができます。モディファイアを使用すると、ラインの
幅、カラー、およびその他の特性をローカルに編集できます。たとえば、ペイン
ト エフェクト（Paint Effects）ツリーのシェイプの編集、その葉の切り取り、
ローカルでのカラーの変更、枝の除去などができます。そしてトゥーンライン
を使用して、ラインの幅、サーフェス、オフセット、ラインカラーなどをロー
カルに編集できます。

同じモディファイアを複数のノードにコネクトすることができます。たとえば、
多数のラインモディファイアを同じオブジェクトに割り当てることができます。
さまざまなモディファイアのインフルエンスは、一緒にブレンドされます。ライ
ンモディファイアノードは、ワールド空間での位置に基づいてラインに作用す
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る球体または立方体のシェイプです。オブジェクトに対してモディファイアをペ
アレント化またはコンストレインして、一緒に移動するようにします。

ライン モディファイアをトゥーン ラインに適用するには

1 モディファイアを反映させるトゥーンラインを選択します。

2 トゥーン > モディファイアの作成（Toon > Create Modifier）を選択しま
す。lineModifier ノードが作成されます。

3 モディファイアのシェイプとして、立方体（Cube）または球体（Sphere）
を選択します。

4 lineModifier ノードで、トゥーンラインに作用させるアトリビュートを変
更します。詳細については、lineModifier ノード (57 ページ)を参照してく
ださい。

5 モディファイアをトランスフォームして、トゥーンラインにどのように影
響しているかを確認します。

6 オプションで、モディファイアをオブジェクトに対してペアレント化し、
一緒に移動するようにします。

16 | 第 1 章   トゥーン シェーディング



トゥーンシーンで追加のラインをペイントする
追加のトゥーンライン（たとえば、キャラクタの口や鼻の真ん中を通る単一の
ライン）をペイントする場合、ペイント エフェクト（Paint Effects）ブラシを使
用します。ブラシの圧力スケール（Pressure Scale）アトリビュートをキーフ
レーム設定することで、ペイントしたラインをアニメートすることもできます。

追加のラインをペイントするには

1 ペイントするサーフェスを選択し、ペイントエフェクト > ペイント可能に
する（Paint Effects > Make Paintable）を選択します。

2 ペイントエフェクト（Paint Effects）ブラシを選択します（ペイントエフェ
クト > ブラシを取得（Paint Effects > Get Brush））。

3 トゥーンラインを表示させるオブジェクトのサーフェス上に描画します。
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4 オプションで、ストロークの圧力スケール（Pressure Scale）ランプを編集
して、ラインの幅を調整します。

トゥーンラインをポリゴンに変換する
トゥーンラインをポリゴンに変換すると、ジオメトリとして操作したり、mental
ray や Maya ハードウェア（Maya Hardware）レンダラでトゥーンラインをレ
ンダーすることができます。

トゥーン ラインをポリゴンに変換するには

1 変換するトゥーンラインが含まれているジオメトリを選択します。

2 トゥーン > トゥーンをポリゴンに変換（Toon > Convert Toon to

Polygons） を選択します。ペイント エフェクトをポリゴンに変換オプ
ション（Convert Paint Effects to Polygons Options）ウィンドウが表示さ
れます（トゥーンラインの変換では、実際にはペイントエフェクト（Paint
Effects）を変換します）。

3 目的のオプションを選択して変換（Convert）をクリックします。ペイント
エフェクトをポリゴンに変換オプション（Convert Paint Effects to Polygons
Options）ウィンドウ内のオプションの説明に関しては、以下を参照してく
ださい。
頂点カラー モード（Vertex Color Mode） デフォルトはなし（None）で
す。そのほかのオプションには、カラー（Color）とライトによる照射
（Illuminated）があります。
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四角ポリゴン出力（Quad Output） このオプションをオンにすると、出力
が四角形で行われます。デフォルトはオフ（三角形で出力）です。

ストロークを非表示（Hide strokes） これをオンにすると、ポリゴンに変
換したトゥーンラインが非表示になります。トゥーンラインが非表示で
も、そのアトリビュートを（pfxToonShape ノードで）更新することは可
能で、ポリゴンメッシュにも作用します。デフォルトはオンです。

ポリゴン制限（Poly Limit） トゥーンラインがポリゴンに変換されるとき
に、フェースの数がこの値に近づくと変換が停止されます。これによって、
極端に大量のメッシュが生成されてメモリ不足を回避できます。デフォル
トは 100 000 です。0 は無制限を意味します。

トゥーンシェーダによる作業
トゥーン（Toon）メニューで使用できる一連のデフォルトのトゥーンシェーダ
が存在しており、すべて単純なライティングで機能するようデザインされていま
す。トゥーンシェーダを選択したジオメトリに割り当てるときに、シェーダノー
ドが作成されます。シェーダはアトリビュート エディタ（Attribute Editor）で
編集できます。すべてのトゥーンシェーダは、ソリッド カラー（Solid Color）
シェーダを除き、ランプ（Ramp）シェーダを基にしています。ランプ（Ramp）
シェーダで複数のインデックス（色調）を作成できます。詳細については、
『シェーディング』マニュアルの「ランプシェーダ（Ramp Shader）」を参照
してください。高精度レンダリング（High Quality Rendering）をオンにする
と、トゥーンシェーダがレンダリング時にどのように見えるか、シーンビュー
に正確にプレビューできます。

ソリッド カラー（Solid Color） - シェー
ディングされていない一定のカラーでサー
フェスを塗りつぶします。

ライト アングル 2 トーン（Light Angle

Two Tone） - ライト角度に基づいたラン
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プ カラー、ライトの輝度に基づいた明度
をインデックス付けします。

シェーディング ブライトネス 2 トーン
（Shaded Brightness Two Tone） - 拡散

シェーディング ブライトネス 3 トーン
（Shaded Brightness Three Tone） - 拡

シェーディングされた明度に基づいて、 散シェーディングされたブライトネスに
ランプ カラー 1 つをインデックス付けし
ます。

基づいて、3 つのカラーをインデックス付
けします。

リム ライト（Rim Light） - エッジに白い
ハイライトが存在しています。

ダーク プロファイル（Dark Profile） -

ビューの角度とエッジに基づいたカラー
のしきい値です。
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サークルのハイライト（Circle

Highlight） - 丸いハード エッジのあるス
ペキュラ ハイライトを使用した、ライト
角度シェーダです。

トゥーンシェーディングによる作業のヒント
■ すべてのトゥーンラインにトゥーンアウトラインを 1 つ作成できる場合、

複数のトゥーンラインノードを使用してトゥーンラインをカスタマイズし
たい場合があります。カスタマイズしないと、トゥーンラインノードに対
する変更は、そのトゥーンライン（pfxToon）ノードにコネクトされている
すべてのオブジェクトに作用します。

■ 1 つのシーンで複数のトゥーンシェーダを使用することを検討してくださ
い。これを行わないと、シーンビューの更新に時間がかかり、ディペンデン
シーグラフが煩雑になる場合があります。

■ pfxToon ノードでビューポートで表示（Display In Viewport）アトリビュー
トをオフにすると、シーンビューでトゥーンラインの表示をオフにするこ
とができます。表示をオフにしてもオフセット メッシュ（Offset Mesh）プ
ロファイルの表示には作用せず、ペイントエフェクト（Paint Effects）トゥー
ンラィンにのみ作用します。オフセット メッシュ（Offset Mesh）プロファ
イルの表示をオフにするには、pfxToonShape ノードで可視性（Visibility）
オプションをオフにします（オフセットメッシュはグループ化されている
ので、グループに可視性を設定することができます）。

■ 一部のタイプのジオメトリでは、トゥーンラインが正しく表示されない場合
があります。コーンの場合、尖った先端で長細い三角形が接触するので、
トゥーンラインが頂点の部分で丸まって表示される場合があります（詳細
については、下記の図を参照）。これを修正するには、pfxToonShape ノー
ドのプロファイル ライン（Profile Lines）セクションでプロファイルを近づ
ける（Tighter Profile）をオンにします。あるいは、プロファイルラインに
オフセット メッシュ（Offset Mesh）オプションを使用するか、メッシュ上
のサブディビジョンの数を増やします。
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■ ペイント エフェクト（Paint Effects）オプションを使用するときにプロファ
イルラインがギザギザになる場合は、セグメントの長さをリサンプルしま
す。ラインセグメントを調整するには、pfxToonShape ノードのライン リ
サンプリング（Line Resampling）セクションにあるアトリビュートを使用
します。

■ ラインを表示させない場所については、ラインの幅（Line Width）をゼロに
設定します。

■ テクスチャマッピングで作成すると最適なラインもあります。たとえば眉毛
です。

■ トゥーンラインではスイッチノードを考慮しません。

■ pfxToonShape ノードのラインの延長（Line Extend）アトリビュートを使
用し、交差部分でトゥーンラインを延長します。

■ ペイント エフェクト（Paint Effect）ブラシのアトリビュート エディタ
（Attribute Editor）で、エッジのクリップ（Edge Clip）およびエッジ ク
リップの幅（Edge Clip Width）の各アトリビュートをドロップシャドウに
使用して、フェイクシャドウを作成します。詳細については、『ペイント
エフェクトと 3D ペイント』マニュアルの「エッジのクリップ（Edge Clip）、
エッジのクリップデプス（Edge Clip Depth）」を参照してください。

■ 曲率調節（Curvature Modulation）を使用し、曲率に基づいてラインの幅を
スケールします（曲率は、ベースラインの幅に関連させて定義します）。曲
率幅（Curvature Width）ランプで、グラフの左側に直線が表示され、右側
には 180° のねじれが表示されます。グラフの最上部は幅が変更されないま
まになっており、ここで値を下げるとラインの幅が小さくなります。
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波状のトゥーンラインを作成するためのヒント

波状のトゥーンラインの作成方法は複数存在します。このセッションでは、考
えられる 4 つのテクニックに関する情報を提供しています。必要なディテール
のレベルおよびモデル上の三角ポリゴンの密度に応じて、ラインのリサンプリン
グをオンにして最大セグメント長（Max Segment Length）の値を小さくし、
刻みのエフェクトを表示するために十分な制御点を作成します。
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波状のトゥーン ラインを作成するには

1 ラインオフセットとラインの幅のアトリビュートの両方またはいずれかを、
ノイズテクスチャでマップします。
■ ノイズタイプをPerlin ノイズ（Perlin Noise）にします（処理速度を上

げるため）。

■ テクスチャ上でアルファ値のゲイン（Alpha Gain）を調整して、オフ
セットの量を増減させます。

■ ラインのオフセットはラインの幅に関連するので、幅を大きくするとオ
フセットも同様にスケールされます。

■ ノイズテクスチャを刻み状にするため、時間（Time）アトリビュート
に以下のように入力することでアニメートできます。

24 | 第 1 章   トゥーン シェーディング



■ “= time * 5"

■ 時間の値を変更することもできます。つまり、外観をさまざまに変動さ
せることができます。さらに各種のノイズパラメータを試して、目的と
する刻みの状態にします。

■ 不透明度やライン幅をマップして、ギャップを作成することもできま
す。

2 トゥーンライン用のラインモディファイアを作成します。
■ lineModifier ノードで、幅のスケール（Width Scale）を 1 に、サーフェ

スのオフセット（Surface Offset）を 0.01 などに、そしてドロップオフ
ノイズ（Dropoff Noise）を 0.8 前後に設定します。

■ ノイズ周波数（Noise Frequency）を、目的のディテールが得られるよ
うに調整します。デフォルトではエフェクトはラインモディファイアの
内側にのみ存在しますが、2 番目の減衰インデックスを削除すると、モ
ディファイアの外側の領域にも作用します。このノイズはモディファイ
アとともに移動する空間領域ノイズなので、モディファイアを回転また
は移動させると、刻みのような状態が作成されます。

■ ノイズ周波数（Noise Frequency）が少し上下するように変動させるこ
ともできます。

3 ペイントエフェクト（Paint Effects）ブラシを使用します。ペイントエフェ
クト（Paint Effects）ブラシをトゥーンラインに割り当てた場合、フルセッ
トのアトリビュートをブラシノードで使用できます。pfxToon ノードには
簡素化するための内部デフォルトブラシがあり、すべてのペイント エフェ
クト（Paint Effects）アトリビュートを表示するわけではありませんが、
オーバーライドされるノードは少数です。
■ 水彩ブラシストロークなども使用できます。これらを使用するときに、

プロファイルのリサンプル（Resample Profile）を使用して最小/最大セ
グメント長（Min/Max Segment Length）を同じ値にすることをお勧
めします。これによって、ラインが変化するときの一貫性をより適切に
保てます。

■ 一部のブラシのディスプレイスメントアトリビュートを使用するテク
ニックとして、単一のチューブの作成が挙げられますが、これをスト
ロークパスに従わせます。

チューブ（Tubes） = オン

トゥーン シェーディングによる作業のヒント | 25



チューブの完成（Tube Completion） = オフ

ステップごとのチューブ数（Tubes Per Step） = 0

開始チューブ（Start Tubes） = 1.0

パスに追従（Path Follow） = 1.0

セグメント（Segments） = ラインのいずれかのセグメントで最も大きな番
号、またはそれ以上。

さらに、ノイズ（Noise）や乱気流（Turbulence）のワールド ディスプレ
イスメント（World Displacement）などの変形具合の値を試すことができ
ます。また、乱気流のスピードを上げて、アニメートされた刻みのような
状態にします。

必要に応じて、複数のトゥーンラインを同じオブジェクト上にレイヤ化し
て、それぞれに異なるブラシを使用することができます。ストローク
（Stroke）アトリビュート領域の描画の順序（Draw Order）を使用して、
これらの各種ストロークの順序を設定できます。たとえば、水彩の塗り付
けまたはブラー上に鉛筆のラインを作成できます。

4 プロファイルライン（Profile Lines）にオフセットメッシュ（Offset Mesh）
オプションを使用してトゥーンラインを作成し、境界線（Border Lines）
と折り目線（Crease Lines）をオフにします。
■ その結果得られたオフセットメッシュにシェーダを割り当てて、両面

（Double Sided）（メッシュのシェイプ アトリビュート エディタ
（Shape Attribute Editor）のレンダリング詳細（Render Stats）セク
ション）をオンにします。オフセットメッシュはシーン内では選択でき
ないので、アウトライナ（Outliner）で選択する必要があります。そし
て、オーバーライド有効化（Enable Overrides）（アトリビュート エ
ディタ（Attribute Editor）のオブジェクト ディスプレイ（Object
Display）セクション）をオフにします。

■ オリジナルのメッシュを非表示にします。ラインのオフセットまたは幅
をトゥーンシェーダ上にテクスチャリングすると、コンストラクション
ヒストリを設定した状態でポリゴンに変形具合を適用できます。

■ 1 番目のテクニックでの説明と同じ方法で、変形具合をアニメートする
ことができます。その後トゥーンラインをこの波状に変形したメッシュ
に割り当てることができます。
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トゥーンラインのトラブルシューティング
ここでは、トゥーンラインの使用中に発生する可能性のある問題に対する解決
策を紹介します。

トゥーンライン上のギザギザまたはエイリアシング
■ ペイント エフェクト レンダー オプション（Paint Effects Rendering

Options）でオーバーサンプル（Oversample）とポストフィルタのオーバー
サンプル（Oversample Post Filter）をオンにします。

■ レンダー設定（Render Settings）の標準シーンのアンチエイリアシングの精
度（Anti-aliasing Quality）を、中間の精度（Intermediate Quality）以上に
設定します。

注: エイリアシングがトゥーンラインの内側のエッジにしか存在しない場合
は、pfxToon ノードのオクルージョン幅のスケール（Occlusion Width Scale）
がオフになっている場合があるので、これをオンに戻します。ペイント エ
フェクト レンダー オプション（Paint Effects Render Options）のオーバー
サンプル（Oversample）がオンになっていることも確認します。

以下に記載されている問題の多くは、アンチエイリアシングの問題としても現れ
ます。ここにある解決策では改善されない場合は、プロファイルラインをオフ
セット メッシュ（Offset Mesh）方法に設定すると解決する場合がありますす。
あるいは、トゥーンラインをポリゴンに変換する方法もありますが、太いライ
ンでは、ラインが分かれる部分に小さな割れ目が発生する場合があります。もう
1 つの方法としては、イメージファイル用のより高い解像度でレンダーしてか
ら、フィルタリングを使用して目的とする解像度になるまでサイズを小さく変更
します。

プロファイルラインに沿ったライン幅のねじれとポップ

ラインが十分に滑らかでない（つまり、ラインにねじれがあるか、所々で飛び出
ている）場合は、pfxToonShape ノードで次の設定を調整してみます。

■ プロファイル幅調節（Profile Width Modulation）または曲率ベースの幅ス
ケーリング（Curvature Based Width Scaling）のオプションを使用するに
は、スムース プロファイル（Smooth Profile）をオンにする必要がありま
す。
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プロファイル幅調節（Profile Width Modulation）と曲率ベースの幅
（Curvature Based Width）の両方のオプションを正しく動作させるには、
ラインを滑らかに変化させる必要があります。これらのオプションがオンに
なっている場合にスムース プロファイル（Smooth Profile）をオフにする
と、プロファイルラインにねじれが表示される場所ができます（これらの
ねじれはビューラインに沿って表示されるので、必ずしも目立つわけではあ
りません。現在選択しているビューではこれで十分です）。

■ ハードエッジの場合、スムース プロファイル（Smooth Profile）がオフに
なっているかのように動作するプロファイル幅調節（Profile Width
Modulation）と曲率ベースの幅スケーリング（Curvature Based Width
Scaling）のオプションの使用を避けます。

■ ライン リサンプリング（Line Resampling）セクションでプロファイルのリ
サンプル（Resample Profile）をオンにします。これによって、ストローク
の方向が突然変わる原因となる、非常に小さなセグメントができるのを回避
することができます。

■ 場合によっては、三角ポリゴンの密度をより均一にすると、ねじれを回避で
きます。三角ポリゴンが非常に小さい、または細いと、問題が発生する原因
となります。

プロファイルラインがエッジに正確にフィットしない

この問題は一般に、スムース プロファイル（Smooth Profile）についてジオメ
トリが正確にサーフェス（つまり頂点法線で定義されたサーフェスという意味）
に一致していない場合に発生します。簡単な例としてコーンが挙げられますが、
これにはピークをポイントする固定された法線が存在しています。したがって、
この頂点法線から見ると、デフォルトのポリゴンであるコーンは、むしろテッセ
レーションが不十分ななだらかなこぶのようになっています。解決策としては、
プロファイルを近づける（Tighter Profile）をオンにします。これでもまだ不十
分な場合は、スムース プロファイル（Smooth Profile）をオフにする（そして
プロファイル幅調節（Profile Width Modulation）をゼロにして曲率調節
（Curvature Modulation）をオフにする）か、または問題の領域でジオメトリ
のメッシュの解像度を上げます。

プロファイルラインの幅が不安定または均一でない

これは、前出の 2 つの問題（プロファイルラインに沿ったライン幅のねじれと
ポップおよびプロファイルラインがエッジに正確にフィットしない）のいずれ
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かである可能性があります。これらの解決策でこの問題が解消しない場合は、オ
フセット メッシュ（Offset Mesh）プロファイルラインを使用することを検討
してください。

ラインの端が延び過ぎてわずかに突き抜けてしまう

ペイント エフェクト レンダリング オプション（Paint Effects Rendering
Options）のオーバーサンプル（Oversample）をオンにします。オクルージョ
ン幅のスケール（Occlusion Width Scale）もオンにしてみますが、この操作に
よってラインの内側のエッジにエイリアシングが発生する場合があります。ライ
ン オフセット（Line Offset）を 0.5 程度に上げると、アンチエイリアシングが
改善される場合があります。ただし、ライン オフセットによってラインのエッ
ジが延びすぎてしまう可能性もあります。オフセット メッシュ（Offset Mesh）
プロファイルラインが良い解決策になる場合もあります。

ラインがサーフェス間の結合部分に沿って表示される

境界線は開いたエッジ（用紙のエッジなど）に沿った部分でうまく機能します
が、フィレットや滑らかな継ぎ目の位置ではあまりよく機能しません。通常は境
界線（Border Lines）をオフにします。ただし、1 つのエッジが開いているため
境界線を必要としていて、もう 1 つのエッジが継ぎ目に沿っている場合は、同
一平面上の境界の削除（Remove Flush Borders）を使用して継ぎ目上にある境
界だけを取り除くことができます。

生き物のサーフェス（人間の顔など）上に最適な折り目線を作成できな
い

鼻孔の周囲や唇の端に沿った部分など、強く湾曲した器官のサーフェスに沿って
折り目線を生成するには、通常は最小/最大折り目角度（Crease Angle Min/Max）
では不十分です。折り目線がハードになるようにエッジを明示的に定義すること
は可能で、ハード エッジのみに折り目（Hard Creases Only）を使用します。た
だし、モデルを三角形に分割しても、通常は三角形の境界に沿って適切なフィー
チャーラインを作成できるほど十分ではありません。このような場合は、フィー
チャーラインをモデリングするか、またはペイントエフェクト（Paint Effects）
ブラシを使用してフィーチャーラインをジオメトリ上にペイントします。ペイ
ントした後ストローク上で圧力スケールランプを編集して、適切に太線または
細線エフェクトを得ることもできます。
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オブジェクトが移動したりビューが変わるときに、プロファイルトゥー
ンラインに割り当てられた複雑なペイントエフェクト（Paint Effects）
ブラシが跳び回る

ビューに対してオブジェクトを回転するとき、同じプロファイルラインの始点
を維持することは困難です。ただし、プロファイルのリサンプル（Resample
Profile）をオンにすると、エフェクトはより安定します。さらに最小/最大セグ
メント長（Min/Max Segment Length）を固定値に設定すると効果的です。プ
ロファイル幅調節（Profile Width Modulation）はゼロに設定し、曲率調節
（Curvature Modulation）はオフにする必要があります。適切なエフェクトが
波状のラインだけである場合、複雑なペイント エフェクト（Paint Effects）ブラ
シを使用する代わりに、ラインオフセット（Line Offset）アトリビュートをマッ
ピングするほうが良い状態になる場合があることに注意してください。詳細につ
いては、波状のトゥーンラインを作成するためのヒント (23 ページ)を参照して
ください。

mental ray またはMaya ハードウェア（Maya Hardware）レンダラにラ
インが表示されない

トゥーンをポリゴンに変換します。プロファイルラインの場合は、トゥーンラ
インをポリゴンに変換する代わりに、オフセット メッシュ（Offset Mesh）プロ
ファイルを使用することもできます。NURBS やカーブへのペイントエフェクト
（Paint effects）の変換も役立ちます。

シーンビューでのタンブルおよびトゥーンオブジェクトのトランスフォー
ムが、トゥーンアウトラインに割り当てた後遅くなる

これは、新しいビューポイント用にプロファイルラインが再計算されるために
起こります。この問題を処理するにはさまざまな方法があります。

■ トゥーンラインノードでビューポートで表示（Display In Viewport）をオ
フにします。

■ パネルメニューで表示 > ストローク（Show > Strokes）をオフにします（こ
れはペイント エフェクト（Paint Effects）のストロークおよびヘアにも作用
します）。

■ オフセット メッシュ（Offset Mesh）プロファイルラインを使用します。
ビューを変更するときに再構築する必要がなくなります。

■ パフォーマンス設定（Performance Settings）ウィンドウで、ペイント エ
フェクト（Paint Effects）をインタラクティブ（Interactive）に設定します。
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これによって、ビューをタンブルするときにトゥーンラインの構築が無効に
なります。

■ さまざまなトゥーンラインを、すべてのオブジェクト用の 1 つの pfxToon
ノードにではなく、さまざまなオブジェクトに割り当てます。個々のオブジェ
クトをトランスフォームするときに、対象オブジェクトだけを更新すればよ
いので便利です（これはタンブルには役立ちません）。

■ オブジェクトに、折り目線など、プロファイルライン以外のラインが多数あ
る場合は、プロファイルラインだけをオンにして pfxToon ノードを割り当
て、プロファイルライン以外のラインだけがある同じオブジェクトには、別
の pfxToon ノードを割り当てることをお勧めします。こうすれば、プロファ
イルノードで再構築するときに、プロファイルライン以外のラインが構築
される間、さらに待つ必要はありません。

■ プロファイルラインだけをオフにして、レンダリングの前にオンに戻しま
す。

■ ストローク アトリビュート（Stroke Attributes）セクションで表示精度
（Display Quality）を低くします。デフォルトではトゥーンラインは六角柱
のチューブで描画されます。表示精度が低いと三角柱のチューブになり、滑
らかさをゼロにすると単純なラインになります。ライン幅の表示が重要でな
い場合は、メッシュとして描画（Draw As Mesh）をオフにすることもでき
ます。これにより表示スピードが幾分か速くなりますが、格段に速くなるわ
けではありません。
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トゥーンメニュー

トゥーン（Toon）

トゥーン > 塗りつぶしシェーダの割り当て（Toon >
Assign Fill Shader）

選択したジオメトリに塗りつぶしシェーダをアタッチするためのオプション、ソ
リッド カラー（Solid Color）、ライト アングル 2 トーン（Light Angle Two
Tone）、シェーディング ブライトネス 2 トーン（Shaded Brightness Two
Tone）、ダーク プロファイル（Dark Profile）、リム ライト（Rim Light）、サー
クルのハイライト（Circle Highlight）を 1 つ選択します。詳細については、トゥー
ン ラインとシェーディングをシーンに追加する (3 ページ)を参照してください。

トゥーン > アウトラインの割り当て（Tool > Assign
Outline）

このメニューから、選択したジオメトリのアウトラインにトゥーンラインを追加
したり削除したりすることができます。トゥーンラインを割り当てるには、トゥー
ンアウトラインの新しいセットを追加するか、または既存のセットのアトリビュー
トを割り当てます。詳細については、トゥーンラインとシェーディングをシーン
に追加する (3 ページ)を参照してください。

2
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トゥーン > モディファイアの作成（Toon > Create
Modifier）

モディファイアの作成（Create Modifier）を選択すると、立方体または球体の
シェイプロケータが表示され、これを移動、回転、スケールすることができま
す。lineModifierノードのアトリビュートを使用して、ロケータの領域内のトゥー
ンラインの外観を制御します。ロケータは、線の幅、透明度、カラー、および
その他のアトリビュートをローカル編集するときに役立ちます。この操作は、す
べてのペイント エフェクト（Paint Effects）の構成要素に作用します。同じモ
ディファイアを複数のノードに割り当てることができます。たとえば、ペイント
エフェクト（Paint Effects）のストロークとトゥーンラインの両方に同時にモ
ディファイアを作用させることができます。複数のモディファイアを 1 つのオ
ブジェクトに割り当てることもできます。さまざまなモディファイアのインフル
エンスが、一緒にブレンドされます。モディファイアをオブジェクトと一緒にグ
ループ化すると、一緒に移動させることができます。詳細については、モディ
ファイアを使用してトゥーンラインとブラシのアトリビュートを変更する (15
ページ)を参照してください。

トゥーン > カメラのバックグラウンド カラーを設定
（Toon > Set Camera Background Color）

カメラビュー（パースビュー、前面、側面、上面）のバックグラウンドカラー
を設定します。詳細については、トゥーンラインとシェーディングをシーンに
追加する (3 ページ)を参照してください。

トゥーン > トゥーン サンプルの取得（Toon > Get
Toon Example）

トゥーンラインとシェーディングエフェクトのサンプルファイルをインポート
します。これらのファイルを変更してトゥーンスタイルをカスタマイズするこ
とができます。また、サンプルファイルは、独自のトゥーンスタイルの作成方
法を理解するための学習ツールとして使用したり、単にアイデアを得る方法とし
て使用したりできます。詳細については、トゥーンのサンプル (2 ページ)を参
照してください。
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トゥーン > サーフェスの反転（Toon > Reverse
Surfaces）

選択したポリゴンメッシュの法線を反転します。法線でサーフェスの内側と外
側を定義します。これは、プロファイルラインにオフセットサーフェス（Offset
Surface）方法を使用する場合に重要になります。サーフェスを外側ではなく内
側でオフセットすると、正しいプロファイルラインが得られません。また、法
線が正しい方向を向いていない場合にライン オフセット（Line Offset）アトリ
ビュートを使用すると、ラインがサーフェスから外側にではなく、サーフェスの
内側に向かってオフセットされる可能性があります。

トゥーンラインに割り当てられた NURBS またはサブディビジョンサーフェス
の場合、変換されたポリゴンメッシュが生成されています。サーフェスの反転
では、NURBS だけが直接選択されている場合に、この変換されたポリゴンメッ
シュを検出して反転する方法がわかります（変換されたメッシュが描画されま
すが、表示が参照オブジェクトに設定されているので、直接選択することはでき
ません）。したがって、NURBS またはサブディビジョンサーフェスについて、
トゥーンライン作成後に反転を行う必要があります。または、サーフェス
（Surfaces）メニューセットのNURBS の編集 > サーフェス方向の反転（Edit
NURBS > Reverse Surface Direction）を使用します。この操作はマップされた
テクスチャに作用します。後者の方法のほうがより効率的です。前者の方法で
は、NURBS が変更されると必ず、変換されたメッシュ上の法線が再計算される
からです。

トゥーン > ペイントエフェクトブラシをトゥーンラ
インに割り当て（Toon > Assign Paint Effects Brush
to Toon Lines）

選択したペイント エフェクト（Paint Effects）ブラシをトゥーンラインに割り
当てます。厳密に言うと、選択したジオメトリにコネクトされたpfxToonShape
ノードに割り当てます。詳細については、ペイントエフェクトをトゥーンライ
ンで使用する (14 ページ)を参照してください。
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トゥーン > トゥーンをポリゴンに変換（Toon >
Convert Toon to Polygons）

選択したジオメトリのトゥーンラインをポリゴンに変換します。この利点は、
ポリゴンラインを他のレンダラでレンダーできることです。詳細については、
トゥーンラインをポリゴンに変換する (18 ページ)を参照してください。

トゥーン > ラインアトリビュートのペイント（Toon
> Paint Line Attributes）

ラインの幅（Line Width）、ライン オフセット（Line Offset）、ライン不透明
度（Line Opacity）、プロファイル カラー（Profile Color）、折り目のカラー
（Crease Color）、境界カラー（Border Color）の各アトリビュートを、選択し
たトゥーンラインにペイントできます。詳細については、トゥーンラインのア
トリビュートをペイントする (12 ページ)を参照してください。
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トゥーンノード

pfxToonShape ノード
このノードは、選択したオブジェクトにトゥーンラインを割り当てると必ず作成
されます（トゥーン > アウトラインの割り当て（Tool > Assign Outline））。こ
のノードのアトリビュートを編集すると、このノードにコネクトされたジオメト
リ上にあるトゥーンラインの外観を変更できます。以下でこのノードのアトリ
ビュートについて説明します。トゥーン ラインのタイプ (5 ページ)も参照してく
ださい。

共通トゥーン アトリビュート（Common Toon Attributes）

以下のアトリビュートは、pfxToonShape ノードの共通トゥーン アトリビュート
（Common Toon Attributes）セクションに存在しています。

ビューポートで表示（Display In Viewport） トゥーンラインの表示のオン/オフ
を切り替えます。デフォルトではオンに設定されています。

注: ビューポートで表示（Display In Viewport）をオフにしても、オフセット メッ
シュ（Offset Mesh）に設定されたプロファイルには影響しません。

プロファイルライン（Profile Lines） プロファイルラインに、オフ、ペイントエ
フェクト（Paint Effects）、またはオフセットメッシュ（Offset Mesh）のモード
を指定します。

ペイント エフェクト（Paint Effects）ラインを使用している場合は、アウトライ
ンを追従するカーブが構築されます。これらのラインはビューに関連しているの
で、ビューが変更されると再構築されます。

3
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オフセット メッシュ（Offset Mesh）ラインを使用している場合、出力メッシュ
が生成されます。この出力メッシュは、サーフェス法線に沿ってライン幅の分だ
け拡大され、単一面表示で逆向きに設定されます。これによって外側に殻が作成
され、オリジナルのメッシュでレンダーされるときにアウトライン（つまり外郭
線）が作成されますが、実際のラインが生成されることはありません。この方法
は、アニメーションするときにも安定している、組み込みの太線または細線プロ
パティを持つという利点があり、ビューが変更されてもシェイプを更新する必要
がありません。これはレイトレーシングされた反射および屈折にも表示されま
す。

pfxToon ノードには、プロファイルラインの外観を制御する各種のアトリビュー
トが含まれています。詳細については、プロファイルライン（Profile Lines） (
47 ページ)を参照してください。

境界線（Border Lines） 境界に沿ったラインの生成方法を指定します。開いた
エッジ（Open Edge）は、1 つのフェースだけが共有するエッジとみなされ、た
とえば、これを使用すると単純なプレーンの境界の周囲にラインを作成できま
す。プロファイルラインではこの種のエッジは扱わず、サーフェスが十分に閉
じている場合にのみ発生します。シェーダの境界（Shader Boundary）は、エッ
ジにアタッチされたフェースが同じシェーダを共有しない位置に発生します。
pfxToonShape ノードには、境界線の外観を制御する各種のアトリビュートが含
まれています。詳細については、境界線（Border Lines） (50 ページ)を参照し
てください。シェーダの境界（Shader Boundary）は、エッジにアタッチされた
フェースが同じシェーダを共有しない位置に発生します。エッジとシェーダの境
界（Edge and Shader Boundary）は、どちらも境界線に適用されるアトリビュー
トです。

折り目線（Crease Lines） これをオンにすると、内部のハードエッジに沿って
ラインが生成されます。pfxToonShape ノードには、折り目線の外観を制御する
各種のアトリビュートが含まれています。詳細については、折り目線（Crease
Lines） (49 ページ)を参照してください。

交差線（Intersection Lines） デフォルトではオフに設定されています。これを
オンにすると、交差線が表示されます。交差線の詳細については、トゥーンラ
インとシェーディングをシーンに追加する (3 ページ)を参照してください。
pfxToon ノードには、交差線の外観を制御する各種のアトリビュートが含まれ
ています。詳細については、交差線（Intersection Lines） (51 ページ)を参照し
てください。

ラインの幅（Line Width） プロファイルライン、折り目線、および境界線のグ
ローバルな幅を制御します。
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ラインの幅マップ（Line Width Map） ラインの幅（Line Width）を 2D テクス
チャマップを使用して変更します。このアトリビュートは現在定義されている
ラインの幅をスケールしますが、ラインの幅マップ（Line Width Map）の値を
2 倍にすることで、0.5 の値は効果がなくなります。テクスチャの値が 0.25 で
ある場合、ラインの幅はラインの幅（Line Width）アトリビュート値の半分に
なります。ここでテクスチャの値が 1.0 の場合は、ライン幅の値は 2 倍になり
ます。0～1 の範囲外の値を使用することもできます（ファイルテクスチャの場
合、通常はテクスチャ上のアルファゲインを増加させる必要があります）。ラ
インが存在するサーフェスの UV 空間に、テクスチャがマップされます。太い/
細いのエフェクトに加えて、テクスチャ値ゼロを使用して、ライン情報全体を
所々でブロックすることもできます。

注: 3D、2D 投影、および環境テクスチャはサポートされていません。

ライン オフセット（Line Offset） サーフェス法線に沿ってラインをオフセット
します。オフセットの量は、ラインの幅（Line Width）に関連しています。1.0
の値を使用するとラインはサーフェスに接触するだけで、値を 0 にすると、ラ
インはサーフェスを交差して半分になります。

ライン オフセット マップ（Line Offset Map） ライン オフセット（Line Offset）
を 2D テクスチャマップを使用して変更します。ノイズの多いテクスチャを使
用すると、波状のラインが作成されます。このアトリビュートは、現在定義され
ているラインオフセットをスケールします。テクスチャの値が 0.5 の場合、ラ
インのオフセットはライン オフセット（Line Offset）アトリビュート値の半分
になります。ラインが存在するサーフェスの UV 空間に、テクスチャがマップさ
れます。

注: 3D、2D 投影、環境テクスチャはサポートされていません。
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ライン終端の細線化（Line End Thinning） ラインが十分に太くなるライン終端
からの距離を制御します。オブジェクトによっては、開いたラインの先端を確認
するため、プロファイル分割角度（Profile Break Angle）の値を下げる必要があ
る場合があります。大部分のサーフェスでは、開いた先端のない閉じたライン
が、プロファイルラインに形成されています。プロファイルが続いていると、
オブジェクトの背後に行ったときに非表示になることがあります。したがって、
ラインが閉じていても開いたラインの先端があるように見える場合があり、ライ
ン終端の細線化（Line End Thinning）のエフェクトが現れません。折り目線は
プロファイルラインや境界線よりも、開いたラインの先端が現れる傾向が強く
なっています。ブレイク角度を使用して、ラインが強くカーブしている開いたラ
インの先端を作成できます。

40 | 第 3 章   トゥーン ノード



ラインの延長（Line Extend） ラインの先端が単純に交差するのではなくコー
ナーで交差するように、ラインの先端を延長します。ラインの延長（Line
Extend）で、鉛筆を使用した下書きスタイルのラインをシミュレートします。
ライン終端の細線化（Line End Thinning）のように、オブジェクトによっては、
ラインの先端を確認するために分割角度（Break Angle）の値を下げる必要があ
る場合があります。大部分のサーフェスでは、開いた先端のない閉じたライン
が、プロファイルラインに形成されています。プロファイルが続いていると、
オブジェクトの背後に行ったときに非表示になることがあります。したがって、
ラインが閉じていても開いた先端があるように見える場合があり、ラインの延長
（Line Extend）のエフェクトが現れません。折り目線はプロファイルラインや
境界線よりも、開いたラインの先端が現れる傾向が強くなっています。ブレイク
角度を使用して、ラインが強くカーブしている開いたラインの先端を作成できま
す。

ライン不透明度（Line Opacity） プロファイルライン、折り目線、および境界
線の不透明度を制御します。不透明度 0 で完全に透明になり、不透明度 1 で完
全に不透明になります。

ライン不透明度マップ（Line Opacity Map） ラインの不透明度を 2D テクスチャ
マップを使用して変更します。このアトリビュートは、現在定義されているライ
ンの不透明度をスケールします。テクスチャの値が 0.5 の場合、ラインの不透明
度はライン不透明度（Line Opacity）アトリビュート値の半分になります。ライ
ンが存在するサーフェスの UV 空間に、テクスチャがマップされます。

注: 3D、2D 投影、環境テクスチャはサポートされていません。

ライティング ベースの幅（Lighting Based Width） このアトリビュートは、線
を調整するために太いエフェクトまたは細いエフェクトを作成するときに役立ち
ます。ライン幅は拡散光の輝度でスケールされます。より明るい領域では線が細
くなります。シャドウのある暗い領域ではラインが全幅になります。負の値を使
用すると逆の効果を得られます。使用されているライティングは、ローカルの
サーフェス法線に関連する拡散光の照明です。
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オクルージョン幅のスケール（Occlusion Width Scale） このオプションはペイ
ント エフェクト（Paint Effects）プロファイル ライン専用であり、オフセット
メッシュ（Offset Mesh）プロファイル ラインには適用されません。

プロファイルラインを生成するペイント エフェクト（Paint Effects）ブラシス
タンプの中心は、オブジェクトのサーフェス上に位置しています。このオプショ
ンをオフにすると、サーフェスの後ろに隠れている（非表示になっている）ブラ
シストロークの内側部分はレンダーされません。このようにラインとオブジェ
クトの重なる部分が後ろに隠れるため、ラインエッジの内側が滑らかになりま
す。つまり、サーフェスのエッジで内側のブラシストロークのエッジが作成さ
れます。これはサーフェスのトポロジ（ジオメトリ）に基づいているので、この
エッジにはレンダリング時にエイリアシングのアーティファクトが表示される場
合があります。

このオプションをオンにすると、サーフェスの後ろに隠れている内側部分も含め
て、ブラシスタンプ全体がレンダーされます。ブラシストロークをより幅広く
より自然に見えるようにすると、エイリアシングのアーティファクトが少なくな
ります。

このオプションをオンにすると、次のような問題が発生することがわかっていま
す。

■ ラインが非常に太いと、適切な位置よりも深くオブジェクトに食い込んでし
まいます。
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■ 特殊な状況では、サーフェスが突然変化する位置で、ラインの輪郭がぼやけ
る場合があります。

注: ブラシをトゥーンラインに割り当てると、ブラシノードのオクルージョ
ン幅のスケール（Occlusion Width Scale）の設定により、トゥーンノード
の設定がオーバーライドされます。

ローカル オクルージョン（Local Occlusion）
2 つのフェースの距離が折り目線の厚さよりも近い場合、トゥーンラインが
フェースの間から表示されることがあります。

ローカル オクルージョン（Local Occlusion）オプションを使うと、（レン
ダー時ではなく）ラインを作成する前に、可視性オクルージョンの計算を行
うことができます。オクルージョンはワイヤフレーム表示モードで表示する
ことができ、また、トゥーンラインをペイントエフェクトからポリゴンに
変換する場合にポリゴンカウントを減らします。

すべてのトゥーン サーフェス（All Toon Surfaces）
トゥーンラインが、その pfxToon ノードに割り当てられたすべてのオブジェ
クトにオクルードされます。
ただし、シーンに複数の pfxToon ノードがある場合、ある pfxToon グルー
プによる別グループのオクルージョンを計算するには、レンダー時にオクルー
ジョンを行う必要があります。
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ライン サーフェス（Line Surface）
トゥーンラインは、ラインを生成するサーフェスのみにオクルードされま
す。
レンダー時のオクルージョンでは、その他のオブジェクトによるオクルージョ
ンを処理します。ただし、サーフェス自体のラインがサーフェスの後ろに隠
れる場合、ローカルオクルージョンによって簡単に問題を回避できるため、
ローカルオクルージョンは通常、ラインの精度にとって最も重要なものにな
ります。

オクルージョン許容値（Occlusion Tolerance）
ローカルオクルージョンの使用時に、オクルードするラインを定義する際に
ラインをカメラ方向に移動する距離です。小さい値を設定する必要がありま
すが、ライン上のポイントがラインが位置している三角形の後ろにずれると
いう問題を回避するために、ゼロ以外の値とする必要があります。
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デプス バイアス（Depth Bias）
このオプションは、ラインが位置しているローカルオブジェクトにオクルー
ドされないよう、ラインのデプス値をカメラ方向に移動させます。このオプ
ションはオクルージョン許容値（Occlusion Tolerance）と似ていますが、レ
ンダー時に考慮されます。
場合によっては、オクルージョン幅のスケールによってシーン内にぼやけた
アーティファクトが作成されることがあるため、オクルージョン幅のスケー
ル（Occlusion Width Scale）をオフにする必要があります。
作成された場合は、オクルージョン幅のスケール（Occlusion Width Scale）
オプションをオフにし、デプス バイアス（Depth Bias）オプションを使って
アンチエイリアシングアーティファクトを消去することができます。
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デプスバイアス値が高すぎると、ラインがその前にあるオブジェクトを通し
て見えてしまうことがあります。この場合、ローカルオクルージョン（Local
Occlusion）をすべてのトゥーン サーフェス（All Toon Surfaces）またはラ
インサーフェス（Line Surface）に設定してラインをオクルードします。ロー
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カル オクルージョン（Local Occlusion）は、デプスバッファオクルージョ
ンには依存しないため、デプスバイアスの値を上げても、折り目線は適切に
オクルードされます。

プロファイル ライン（Profile Lines）

以下のアトリビュートは、pfxToonShape ノードのプロファイル ライン（Profile
Lines）セクションに存在しています。

プロファイル カラー（Profile Color） プロファイルラインの入力カラーです。
これは 2D テクスチャでテクスチャマッピングされる場合があります。ライン
のカラーは、サーフェスにマップされたテクスチャのカラーに基づいて導き出さ
れます。

注: 3D、2D 投影、環境テクスチャのマッピングはサポートされていませんが、
トゥーンラインをポリゴンに変換してから、その結果に対して 3D テクスチャ
が含まれたシェーダを適用することができます。

プロファイル ラインの幅（Profile Line Width） プロファイルラインまたは外
郭線の幅の相対的なスケールです。
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プロファイル幅調節（Profile Width Modulation） プロファイルラインの幅を
ビューの角度に関連させて変更します。スムースプロファイル（Smooth Profile）
をオフにした場合は、プロファイル幅調節（Profile Width Modulation）を使用
しないでください。

プロファイル分割角度（Profile Break Angle） プロファイルラインが分割され
るときの角度（度単位）です。この角度より小さいほうのラインセグメントは、
ラインに結合されます。0 の値で、すべてのラインが 1 セグメントだけの長さに
なります。180 の値で、すべての隣り合うセグメントが一緒にラインに結合され
ます。

デプスオフセット（Depth Offset） ビューの方向に沿ってプロファイルライン
をオフセットします。これによって、プロファイルがオブジェクトに対して内部
にある位置で、ラインの幅をより段階的にすることができます。

スムース プロファイル（Smooth Profile） この設定をオンにすると、補間され
た法線に基づいてプロファイルが計算されます。オフになっている場合は、プロ
ファイルカーブはポリゴンエッジ上にのみ存在します。オフの状態ではプロファ
イルが正確に可視となった境界に常に存在することが保証されますが、ビューの
変化やオブジェクトの変形に従って目立たない段差に入り込みます。スムース
プロファイル（Smooth Profile）をオンにすると、プロファイルは滑らかに持続
的に変化しますが、サーフェスが大雑把に三角化されている位置でエッジから入
り込む場合があります。すべてのジオメトリのエッジがハードである場合、ス
ムース プロファイル（Smooth Profile）がオフになっているかのように見えま
す。

プロファイルを近づける（Tighter Profile） このオプションは、スムース プロ
ファイル（Smooth Profile）がオンになっている場合にしか使用できません。プ
ロファイルを近づける（Tighter Profile）をオンにすると、スムース プロファイ
ルがわずかにメッシュプロファイルエッジに近づきます。特に頂点法線がエッ
ジの方向にうまく一致していない場合に効果的です。プリミティブの円錐はこの
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状態の良い例です。この場合、プロファイルを頂点法線から生成するとうまく機
能しません。これは、法線が先のとがった円錐を丸い山として定義するためで
す。円錐では、プロファイルを近づける（Tighter Profile）という方法により円
錐の頂点に近づく中ほどまでプロファイルが押し込まれます。これよりも近づけ
てフィットさせるには、円錐上の分割数を増やすか、またはスムース プロファ
イル（Smooth Profile）をオフにします。

折り目線（Crease Lines）

以下のアトリビュートは、pfxToonShape ノードの折り目線（Crease Lines）セ
クションに存在しています。

折り目のカラー（Crease Color） 折り目線の入力カラーです。これは 2D テク
スチャでテクスチャマッピングされる場合があります。ラインのカラーは、サー
フェスにマップされたテクスチャのカラーに基づいて導き出されます。

注: 3D、2D 投影、環境テクスチャのマッピングはサポートされていませんが、
トゥーンラインをポリゴンに変換してから、その結果に対して 3D テクスチャ
が含まれたシェーダを適用することができます。

折り目線の幅（Crease Line Width） 折り目線またはハードエッジラインの幅
の相対的なスケールです。

折り目幅調節（Crease Width Modulation） 折り目線の幅をビューの角度に関
連させて変更します。

折り目分割角度（Crease Break Angle） 折り目線が分割されるときの角度（度
単位）です。この角度より小さいほうのラインセグメントは、ラインに結合さ
れます。0 の値で、すべてのラインが 1 セグメントだけの長さになります。180
の値で、すべての隣り合うセグメントが一緒にラインに結合されます。

最小折り目角度（Crease Angle Min） 折り目によって形成されるフェース間の
開始角（度単位）です。ラインの太さは、最小角度での幅ゼロから徐々に変化さ
せて、最大角度でもっとも太くすることができます。ハード エッジのみに折り
目（Hard Creases Only）をオフにしている場合、角度ゼロですべてのエッジが
描画されます。

最大折り目角度（Crease Angle Max） 折り目線の太さが最大となるフェース間
の角度（度単位）です。ハード エッジのみに折り目（Hard Creases Only）をオ
フにしている場合、角度ゼロですべてのエッジが描画されます。

ハード エッジのみに折り目（Hard Creases Only） このオプションをオンにす
ると、ハードになっているエッジに沿った部分にだけ折り目線が生成されます。
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バック フェースの折り目（Backfacing Creases） ビューの反対側を向いている
折り目にラインが生成されるのを防ぐには、このオプションをオフにします。こ
のオプションは折り目線のみに使用可能です。プロファイルラインはバック
フェースエッジには存在せず、境界ラインはサイドの概念がないオープンエッ
ジに沿っているため、使用できません。

境界線（Border Lines）

以下のアトリビュートは、pfxToonShape ノードの境界線（Border Lines）セク
ションに存在しています。

境界カラー（Border Color） 境界線の入力カラーです。これは 2D テクスチャ
でテクスチャマッピングされる場合があります。ラインのカラーは、サーフェ
スにマップされたテクスチャのカラーに基づいて導き出されます。

注: 3D、2D 投影、環境テクスチャのマッピングはサポートされていませんが、
トゥーンラインをポリゴンに変換してから、その結果に対して 3D テクスチャ
が含まれたシェーダを適用することができます。

境界線の幅（Border Line Width） 境界線の幅の相対的なスケールです。

境界幅調節（Border Width Modulation） 境界線の幅をビューの角度に関連さ
せて変更します。

境界分割角度（Border Break Angle） 境界線が分割されるときの角度（度単位）
です。この角度より小さいほうのラインセグメントは、ラインに結合されます。
0 の値で、すべてのラインが 1 セグメントだけの長さになります。180 の値で、
すべての隣り合うセグメントが一緒に 1 つのラインに結合されます。
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同一平面上の境界の削除（Remove Flush Borders） メッシュが接触し、一致す
る法線がある境界を削除します。

同一平面上の許容値（Flush Tolerance） 最大距離の境界制御点は、同一平面上
にある境界線または共有する境界線を削除するときに、それぞれ別々に存在させ
ることができます。

同一平面上の最大角度（Flush Angle Max） 同一平面上にある境界線または共有
する境界線を削除するときに、境界頂点法線をそれぞれ別々に存在させることが
可能な最大角度（度単位）です。

交差線（Intersection Lines）

以下のアトリビュートは、pfxToon ノードの交差線（Intersection Lines）セク
ションに存在しています。

交差カラー（Intersection Color） 交差線の入力カラーです。これは 2D テクス
チャでテクスチャマッピングされる場合があります。ラインのカラーは、サー
フェスにマップされたテクスチャのカラーに基づいて導き出されます。

注: 3D、2D 投影、環境テクスチャのマッピングはサポートされていませんが、
トゥーンラインをポリゴンに変換してから、その結果に対して 3D テクスチャ
が含まれたシェーダを適用することができます。

交差線の幅（Intersection Line Width） 交差線の幅の相対的なスケールです。

交差幅調節（Intersection Width Modulation） 交差線の幅をビューの角度に関
連させて変更します。

交差分割角度（Intersection Break Angle） 交差線が分割されるときの角度（度
単位）です。この角度より小さいほうのラインセグメントは、ラインに結合さ
れます。0 の値で、すべてのラインが 1 セグメントだけの長さになります。180
の値で、すべての隣り合うセグメントが一緒にラインに結合されます。

最小交差角度（Intersection Angle Min） 交差線によって形成されるフェース間
の開始角（度単位）です。ラインの太さは、最小角度での幅ゼロから徐々に変化
させて、最大角度でもっとも太くすることができます。角度ゼロで、すべての交
差するエッジが描画されます。最小および最大交差角度を変更すると、ラインが
同一平面上の交差に沿わないようにできますが、交差角度が急なラインはまだ存
在しています。
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最大交差角度（Intersection Angle Max） 交差線の太さが最大となるフェース
間の角度（度単位）です。角度ゼロで、すべての交差線が最大の太さで描画され
ます。

自己交差（Self Intersect） このオプションをオンにすると、サーフェス自体が
交差する位置にラインが生成されます。

曲率ベースの幅スケーリング（Curvature Based Width Scaling）

以下のアトリビュートは、pfxToon ノードの曲率ベースの幅スケーリング
（Curvature Based Width Scaling）セクションに存在しています。曲率ベース
の幅スケーリング（Curvature Based Width Scaling）の使用を図示した例につ
いては、トゥーンシェーディングによる作業のヒント (21 ページ)を参照してく
ださい。

注: プロファイルラインが表示されている場合は、スムース プロファイル
（Smooth Profile）をオンにする必要があります。プロファイルのリサンプル
（Resample Profile）も、最小セグメント長値（Min Segment Length）を大き
くする場合に使用できます。

曲率調節（Curvature Modulation） ラインの 3D 曲率に関連させてラインの幅
を変更します。曲率幅（Curvature Width）グラフを使用して、曲率をラインの
幅に作用させる方法を制御します。

曲率幅（Curvature Width） 曲率調節（Curvature Modulation）をオンにして、
曲率をラインの幅に作用させる方法を曲率幅（Curvature Width）グラフで制御
します。曲率幅（Curvature Width）グラフからサンプリングした入力位置が曲
率です。ここでグラフの左側は曲率ゼロ（直線）で右側は 180° の角度で完全に
曲がっています。次にグラフの出力値（垂直の位置）を使用して、カレントの幅
に使用するスケール係数を定義します。このように、グラフが 1.0 の値で水平ラ
インになっている場合、ラインの幅は変わりません。ここでグラフがゼロの場
合、ラインの幅はゼロになります。

ライン リサンプリング（Line Resampling）

以下のアトリビュートは、pfxToon ノードのライン リサンプリング（Line
Resampling）セクションに存在しています。

プロファイルのリサンプル（Resample Profile） プロファイルに沿ったポイン
トは、通常、サーフェスのジオメトリに応じて不規則に間隔を空けて配置されま
す。チューブを有効にしてペイント エフェクト（Paint Effects）ブラシにトゥー
ンラインを割り当てる場合、これが特に目立ちやすくなり、シーンをアニメー
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トするときにチューブが跳び回ることがあります。プロファイルのリサンプル
（Resample Profile）をオンにすると、制御点の間隔が均一になった状態でプロ
ファイルラインがリサンプルされます。その結果ストロークが滑らかになり、
跳び回ることも少なくなります。リサンプルの間隔は、コーナーエッジが丸ま
らないように小さくする必要があります。

折り目のリサンプル（Resample Crease） 折り目に沿ったポイントは、ポリゴ
ンエッジのサイズに従って通常の間隔で配置されます。単純なオブジェクトで
は、ライン終端の細線化（Line End Thinning）などのエフェクトに対しては十
分な制御点が供給されません。折り目のリサンプル（Resample Crease）を使用
すると、制御点を増減して折り目線をサンプリングする機能、およびカーブの制
御点間の距離をワールド空間で固定する機能が得られます。これによって、スク
リーン スペースでリサンプリング（Screen Space Resampling）がゼロでない
場合は、アニメートするときに折り目線が小刻みに変動することがあります。リ
サンプルの間隔は、コーナーエッジが丸まらないように小さくする必要があり
ます。

境界のリサンプル（Resample Border） 境界に沿ったポイントは、ポリゴンエッ
ジのサイズに従って通常の間隔で配置されます。単純なオブジェクトでは、ライ
ン終端の細線化（Line End Thinning）などのエフェクトに対しては十分な制御
点が供給されません。境界のリサンプル（Resample Border）を使用すると、制
御点を増減して境界線をサンプリングする機能、およびカーブの制御点間のワー
ルド空間の距離を固定する機能が得られます。これによって、スクリーンスペー
スでリサンプリング（Screen Space Resampling）がゼロでない場合は、アニ
メートするときに境界線が小刻みに変動することがあります。リサンプルの間隔
は、コーナーエッジが丸まらないように小さくする必要があります。

交差のリサンプル（Resample Intersection） 交差に沿ったポイントは通常、不
規則な間隔で配置されます。これは、三角形がエッジに沿ってオーバーラップし
ていることが原因です。

チューブを有効にしてペイント エフェクト（Paint Effects）ブラシにトゥーン
ラインを割り当てる場合、これが特に目立ちやすくなります。チューブがシーン
をアニメートするときに跳び回ることがあります。交差のリサンプル（Resample
Intersection）をオンにすると、制御点の間隔が均一になった状態で交差線がリ
サンプルされます。その結果ストロークが滑らかになり、跳び回ることも少なく
なります。リサンプルの間隔は、コーナーエッジが丸まらないように小さくす
る必要があります。

最小セグメント長（Min Segment Length） プロファイルのリサンプル
（Resample Profile）がオンになっている場合に、プロファイル上にある制御点
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間の、設定可能な最短距離です。この距離が長いと、プロファイルカーブは非
常に大雑把にサンプリングされる場合があります。これはポリゴンなどに出力す
る場合には役立ちます。出力先ではセグメント数が最小限に維持されます。スク
リーン スペースでリサンプリング（Screen Space Resampling）とともに使用
する場合も、このオプションで距離が離れたプロファイルを簡略化することがで
きます。

最大セグメント長（Max Segment Length） プロファイルのリサンプル
（Resample Profile）がオンになっている場合に、プロファイル上にある制御点
間の、設定可能な最長距離です。この距離が短いと、プロファイルカーブ上に
多数の制御点ができる場合があります。この値を非常に大きくすると、プロファ
イルカーブには元々の数の制御点が存在しますが、オリジナルのカーブ全体に
均一に配分されます。最大セグメント長（Max Segment Length）を十分に低
くしないと、コーナーが丸まることがあります。

スクリーン スペースでリサンプリング（Screen Space Resampling） スクリー
ンスペースでアウトラインカーブのリサンプリングを実行する度合いを制御し
ます。この値が 1.0 の場合、セグメントはスクリーンスペースから一定の距離
に存在します。0.0 の場合は、この距離はワールド空間内で固定されます。1.0
～0.0 の間でこれらの 2 つのサンプリング方法が補間されます。これを使用する
と、プロファイルカーブを距離に応じてより単純にすることができます。チュー
ブが有効になったブラシが存在し、トゥーンラインに割り当てられていると、
チューブの数は距離に応じて少なくなります（距離がゼロより長い場合）。

スクリーンスペース幅のコントロール（Screenspace Width Control）

pfxToonShape ノードのスクリーン スペース幅のコントロール（Screenspace
Width Control）セクションにあるアトリビュートは、ペイント エフェクト
（Paint Effects）ブラシのアトリビュート エディタ（Attribute Editor）にある
スクリーン スペース幅のコントロール（Screenspace Width Control）セクショ
ン（ブラシ プロファイル（Brush Profile）のサブセクション）のアトリビュー
トと同じです。これらのアトリビュートの説明については、『ペイント エフェ
クトと 3D ペイント』マニュアルの「ブラシプロファイル（Brush Profile）」を
参照してください。

スクリーンスペース幅（Screenspace Width）をオフにすると、ペイントエフェ
クトトゥーンラインはカメラのトゥーンラインよりもはるかに細く表示されま
す。ただし、オンにした場合は、ラインがカメラからどれほど近くまたは遠くに
存在していても、ペイント エフェクト（Paint Effects）トゥーンラインの幅に
差異がなくなります。スクリーン スペース幅（Screenspace Width）をオンに
すると、ピクセル単位での最小幅（Min Pixel Widths）、ピクセル単位での最大
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幅（Max Pixel Widths）が考慮されます。シーン内のすべてのデ奥行きでブラ
シ幅を維持するには、このオプションをオンにしてください。カートゥーンのよ
うなアウトラインを一定の幅に保ちたい場合などは、このスクリーンスペース
幅をオンに設定してください。

ブラシストロークの幅は通常はワールド座標空間にありますが、3D 空間では一
定に見えます。スクリーン スペースとは、レンダリングしたイメージの平坦な
2D 空間を指します（たとえばペイントキャンバス）。幅がスクリーン空間内で
定義されている場合、幅はイメージの全体サイズを基準にします。オブジェクト
の距離に関わらず幅は一定です。

ストローク アトリビュート（Stroke Attributes）

以下のアトリビュートは、pfxToonShape ノードのストローク アトリビュート
（Stroke Attributes）セクションに存在しています。Pfx のランダム化（Pfx
Randomize）以外はすべて標準的なストロークのアトリビュートで、strokeShape
ノードにあります。

表示精度（Display Quality） 選択したストロークのワイヤフレームの表示の滑
らかさを設定します。詳細については、『ペイント エフェクトと 3D ペイント』
マニュアルの「strokeShape ノード」を参照してください。

メッシュとして描画（Draw As Mesh） ストロークをレンダングした場合の外観
を、インタラクティブにプレビューします。詳細については、『ペイント エフェ
クトと 3D ペイント』マニュアルの「strokeShape ノード」を参照してくださ
い。

シード（Seed） ランダム化するブラシアトリビュートに使用する乱数列を設定
します。詳細については、『ペイント エフェクトと 3D ペイント』マニュアル
の「strokeShape ノード」を参照してください。

描画の順序（Draw Order） シーン内でのストロークペイントの順序を設定しま
す。詳細については、『ペイント エフェクトと 3D ペイント』マニュアルの
「strokeShape ノード」を参照してください。

サーフェスのオフセット（Surface Offset） 次回のストロークと、そのストロー
クがペイントされるオブジェクトまたはプレーン（サーフェス）との間の距離
（オフセット値）をワールド単位で指定します。詳細については、『ペイント
エフェクトと 3D ペイント』マニュアルの「ペイントエフェクト > ペイントエ
フェクトツール（Paint Effects > Paint Effects Tool）ペイントエフェクト > ペ
イントエフェクトツール（Paint Effects > Paint Effects Tool）」を参照してく
ださい。
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Pfx のランダム化（Pfx Randomize） このオプションをオンにすると、各カー
ブにペイント エフェクト（Paint Effects）用の新しいランダムシードが与えら
れます。このためには、チューブが有効になった pfx ブラシが存在し、トゥー
ンラインに割り当てられていることが必要です。アニメートするときにこのオ
プションがオンになっていると、プロファイルラインのチューブが跳び回る場
合があります。

コントロール カーブ（Control Curves）

以下のアトリビュートは、pfxToon ノードのコントロール カーブ（Control
Curves）セクションに存在しています。これらのアトリビュートの詳細および
使用方法については、『ペイント エフェクトと 3D ペイント』マニュアルの「コ
ントロールカーブを使用してチューブの動作を変更する」を参照してください。

チューブが有効になっているブラシをトゥーンラインに割り当てると、ペイン
ト エフェクト（Paint Effects）のコントロールカーブでチューブの方向を指定
できます。たとえば、プロファイルラインから動線を作成できます。

メッシュ出力（Mesh Output）

以下のアトリビュートは、pfxToon ノードのメッシュ出力（Mesh Output）セ
クションに存在しており、strokeShape ノードにもあります。詳細については、
『ペイント エフェクトと 3D ペイント』マニュアルの「strokeShape ノード」を
参照してください。

NURBS 出力（NURBS Output）

以下のアトリビュートは、pfxToon ノードのNURBS 出力（NURBS Output）セ
クションに存在しており、strokeShape ノードにもあります。詳細については、
『ペイント エフェクトと 3D ペイント』マニュアルの「strokeShape ノード」を
参照してください。

レンダリング詳細（Render Stats）

以下のアトリビュートは、pfxToon ノードのレンダリング詳細（Render Stats）
セクションに存在しています。これらのアトリビュートの詳細については、『レ
ンダリング』マニュアルの「レンダリング詳細」を参照してください。
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pfxToonProfileShader ノード
このノードは、プロファイル ライン（Profile Lines）が初めてオフセット メッ
シュ（Offset Mesh）オプションに設定されるときに作成されます（詳細につい
ては、pfxToonShape ノードのプロファイルライン（Profile Lines）を参照）。
pfxToonProfileShader は単純にサーフェスシェーダ（Surface Shader）マテリ
アルであり、ソリッドカラーを持っています。pfxToon ノードの outColor は
このサーフェスシェーダマテリアルの outColor に接続されるので、プロファ
イルラインのカラーを更新およびテクスチャリングすると、このシェーダにも
作用します。プロファイル ライン（Profile Lines）タイプをペイント エフェク
ト（Paint Effects）に戻すかまたはオフにすると、追加したシェーダおよびメッ
シュノードはまだ存在していますが、出力メッシュに三角ポリゴンがないので
効果がなくなります。

注: これは pfxToonShape ノードで使用する内部ノードです。

lineModifier ノード
このノードは、トゥーンラインモディファイアを作成するときに作成されます。
詳細および説明図については、モディファイアを使用してトゥーンラインとブ
ラシのアトリビュートを変更する (15 ページ)を参照してください。以下で
lineModifier ノードのアトリビュートについて説明します。

注: 1 つのトゥーンラインに複数のラインモディファイアノードを適用するこ
とができます。

ライン モディファイア アトリビュート（Line Modifier Attributes）
シェイプ（Shape） ラインモディファイアのシェイプを定義します。この設定
は、選択されたシェイプの境界の外には影響しません。ドロップオフ（Dropoff）
グラフアトリビュートは、ドロップオフの右エッジがシェイプの外側のエッジ
になり、左がシェイプの中心になるように、シェイプを基準に定義されます。

幅のスケール（Width Scale） カレントのライン幅に乗算します。1.0 の値では
何も効果がなく、ゼロの値では幅がゼロにスケールされます。

幅のオフセット（Width Offset） 現在の線幅を増加させます。値が 0.0 の場合、
影響はありません。値が 1.0 の場合は、幅を 1 増加します。
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不透明度のスケール（Opacity Scale） 現在の不透明度を増加させます。値が
1.0 の場合、影響はありません。値が 0 の場合は、不透明度が 0 になります。

不透明度のオフセット（Opacity Offset） 現在の線の不透明度を増加させます。
値が 0.0 の場合、影響はありません。値が 1.0 の場合は、線が完全に不透明にな
ります。

サーフェスのオフセット（Surface Offset） 現在の線のサーフェスオフセット
を増加させます。0.0 の値では何も効果がなく、1.0 の値でオフセットを 1.0 ず
つ拡大します。0 のオフセットを実行すると、負の値はクランプされます。

ラインの延長（Line Extend） 現在の線を延長させます。0.0 の値では何も効果
がなく、1.0 の値で延長を 1.0 ずつ拡大します。0 より小さい負の値は制限され
ます。

カラーの修正（Modify Color） このオプションをオンにすると、カラー値は、
減衰値に基づいてラインカラーとブレンドされます。

カラー（Color） カラーの修正をオンにした場合、このカラーが、ドロップオフ
値に基づいてローカルの線のカラーとブレンドされます。

ドロップオフ（Dropoff） ドロップオフとは、個々のリーフ、小枝、フラワー、
チューブなどの間引きのことです。その数は、指定したドロップオフ設定に応じ
て少数の場合も多数の場合もあります。

この設定では、モディファイアの境界内で効果が及ぶ範囲を定義します。減衰を
定数値 1.0（水平のライン）に設定すると、ラインはドロップオフシェイプの境
界内で均等に変更され、シェイプのエッジは急激に変化します。代わりに減衰の
右のエッジをゼロまで変化させると、変化はシェイプのエッジでは調整されず、
センターに向かって調整が加えられていき、徐々に変化していきます。ドロップ
オフグラフアトリビュートは、ドロップオフの右エッジがシェイプの外側のエッ
ジになり、左がシェイプの中心になるように、シェイプを基準に定義されます。

ドロップオフ ノイズ（Dropoff Noise） ドロップオフ値を 3D ノイズで調整し
ます。これによって調整中のパラメータを変動させることができます。たとえ
ば、このアトリビュートを使用して、チューブの幅をランダム化したり、小刻み
に波打たせたりすることができます。

ノイズ周波数（Noise Frequency） ドロップオフノイズの詳細度を制御します。
値が小さいほど、滑らかなノイズになります。3D ノイズは、ラインモディファ
イアシェイプのローカル空間を基準に定義されます。
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ブラシ チューブ アトリビュート（Brush Tube Attributes）

以下の設定を作用させるには、チューブを有効にしてペイントエフェクト（Paint
Effects）ブラシを使用する必要があります。

フォース（Force） ラインモディファイアシェイプの中心からチューブを押し
出すフォースとして機能します。正の値ではセンターから遠ざかる方向に押し込
まれ、負の値ではセンターに向かって押し込まれます。この設定の効果を得るに
は、チューブをオンにしてブラシを使用する必要があります。たとえば、この設
定を使用して、あたかも風のようにペイント エフェクトの木を動かすことがで
きます。

ディレクショナル フォース（Directional Force） ラインモディファイアシェ
イプのローカル X 軸に沿ってチューブを押すフォースとして機能します。この
設定の効果を得るには、チューブをオンにしてブラシを使用する必要がありま
す。

ディスプレイスメント（Displacement） ラインモディファイアシェイプの中
心からチューブを押し出す変形具合として機能します。正の値ではセンターから
遠ざかる方向に押し込まれ、負の値ではセンターに向かって押し込まれます。
フォースアトリビュートと似ていますが、オフセットは、チューブのさらに下
のチューブセグメントには作用しません。この設定の効果を得るには、チュー
ブをオンにしてブラシを使用する必要があります。

ディレクショナル ディスプレイスメント（Directional Displacement） ライン
モディファイアのシェイプのローカル軸に沿って、チューブを押し込む変形具合
として動作します。この設定の効果を得るには、チューブをオンにしてブラシを
使用する必要があります。これはディレクショナルフォースのアトリビュート
に似ていますが、チューブのずっと下にあるチューブのセグメントは、オフセッ
トの影響を受けません。

チューブのスケール（Tube Scale） 生成したペイント エフェクト（Paint
Effects）チューブの長さと幅をスケールします。1.0 の値では何も効果はなく、
0.0 の値ではチューブが消滅した状態までスケールされるので、チューブが生成
されないことになります。この動作は、ブラシのグローバル スケール（Global
Scale）の変更と似ています。この設定の効果を得るには、チューブをオンにし
てブラシを使用する必要があります。

チューブのドロップアウト（Tube Dropout） 生成されるペイント エフェクト
（Paint Effects）チューブの数を少なくします。値が 0.0 の場合、設定に影響は
ありません。値が 1.0 の場合は、チューブは生成されません。この設定の効果を
得るには、チューブをオンにしてブラシを使用する必要があります。
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リーフのスケール（Leaf Scale） ペイント エフェクト ブラシが使用するリーフ
のサイズを拡大します。値が 1.0 の場合、設定に影響はありません。値が 0.5 の
場合は、リーフのサイズは半分になります。この設定の効果を得るには、チュー
ブをオンにしてブラシを使用する必要があります。

リーフのドロップアウト（Leaf Dropout） ペイント エフェクト ブラシが使用
する現在のリーフのドロップアウト値を増加させます。0.0 の値では何も効果が
なく、1.0 の値でドロップアウトを 1.0 ずつ拡大します。効果を作用させるに
は、ここでチューブを有効にしてブラシを使用する必要があります。

フラワーのスケール（Flower Scale） ペイント エフェクト ブラシが使用するフ
ラワーのサイズを拡大します。1.0 の値では何も効果がなく、0.5 の値でフラワー
のサイズが半分になります。この設定の効果を得るには、チューブをオンにして
ブラシを使用する必要があります。

フラワーのドロップアウト（Flower Dropout） ペイント エフェクト（Paint
Effects）ブラシで使用される現在のフラワーのドロップアウト値に加算します。
0.0 の値では何も効果がなく、1.0 の値でドロップアウトを 1.0 ずつ拡大します。
効果を作用させるには、ここでチューブを有効にしてブラシを使用する必要があ
ります。

大枝のドロップアウト（Branch Dropout） ペイントエフェクト（Paint Effects）
ブラシで使用される現在の大枝のドロップアウト値に加算します。0.0 の値では
何も効果がなく、1.0 の値でドロップアウトを 1.0 ずつ拡大します。効果を作用
させるには、ここでチューブを有効にしてブラシを使用する必要があります。

小枝のドロップアウト（Twig Dropout） ペイント エフェクト（Paint Effects）
ブラシで使用される現在の大枝のドロップアウト値に加算します。0.0 の値では
何も効果がなく、1.0 の値でドロップアウトを 1.0 ずつ拡大します。効果を作用
させるには、ここでチューブを有効にしてブラシを使用する必要があります。
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